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Cryptosporidiosis outbreak  
 

The final report of the outbreak control team (OCT) which 
investigated the outbreak of Cryptosporidiosis, Spring 2000, in 
the area supplied with Loch Katrine water, via the Milngavie 
Treatment Works, has been published by Greater Glasgow NHS 
Board (GGNHSB). 
 
The report details the background situation, the investigations 
into the cause of the outbreak, including descriptive 
epidemiology and the results of a case/control study, and makes 
a series of recommendations. There was a total of 90 confirmed  
outbreak cases, including one death. The conclusion of the OCT 
was that the outbreak was strongly associated with drinking 
water from the Loch Katrine supply and linked to 
Cryptosporidium contamination from livestock raised on the 
catchment area (the area from which the reservoir is fed). The 
report makes a series of recommendations relating to; the 
control of water-supply catchment areas where livestock is 
present, the advice given to consumers receiving unfiltered 
water supplies, the laboratory-reporting procedure (13 cases 
reported to Scottish Centre for Infection and Environmental 
Health were not reported to the Health Board) and what further 
research is required. The report will be of interest to CPHMs, 
microbiologists, environmental health officers and water 
authorities and is available from Greater Glasgow NHS Board, 
Public Health Protection Unit (0141 201 4917). It can also be 
found on the GGNHSB website (see under Reports and 
Publications on www.show.scot.nhs.uk/ggnhsb). 
 
Although West of Scotland Water declined to endorse the 
report, it implemented all the relevant recommendations and 
recently announced that sheep-farming on the banks of Loch 
Katrine would cease, citing "economic as well as public health 
reasons". 

Decontamination of surgical 
instruments report 
 
The report (HDL(2001)10) of the Scottish Executive Health 
Department Working Group on the decontamination of surgical 
instruments and medical devices in health-care premises was 
published in Feb 2001. The recommendations of this report and 
risk-management of healthcare-associated infection will be more 
extensively covered in February's edition of the newsletter.  
 
 www.show.scot.nhs.uk/shed/ (click on publications).    

Hogmanay event 2001  
 

This year, as in previous years, Emergency Planning has led 
arrangements for the provision of medical, ambulance and first- 
aid services at the annual event. Whilst not on the same scale as 
Edinburgh’s, our event, nevertheless, is expected to attract a 
city-centre crowd approaching 100,000.  Meeting the potential 
demands of the event, whilst ensuring that city A&E 
departments and ambulance services can continue to meet normal 
requirements, needs substantial planning and considerable 
resources dedicated to the event. There will be 9 doctors and 9 
nurses, supported by 6 ambulance and 100 first-aiders, on duty 
at various locations in the city-centre.  
 
Casualties not suffering from life-threatening injuries will be 
treated at first-aid posts before being taken, if required, to a 
casualty-clearance facility on Ingram Street. This year, the 
facility will also include a medical-observation area where those 
who have “overindulged” can be monitored before being sent 
home, transferred to A&E or “offered” overnight accommodation 
by Strathclyde Police. 
 
Streets within the city centre, principally around George Square, 
the Merchant City and Dunlop Street Car Park, will be 
progressively closed from lunchtime on the 31st December. 
However, emergency access arrangements will be maintained at 
all times. Any queries regarding access for doctors/nurses etc. 
needing to make house calls should be made to “A” Division of 
Strathclyde Police. 
 
Glasgow's event is typically good-humoured but despite every 
effort to make it as safe as possible, around 200 people are 
generally seen by the medical, ambulance and first-aid services. 
The good news is that generally only around 10 require further 
treatment in hospital.  
If you would like to know more, contact Alan Dorn on 0141 201 
4554 or, Tracy Curtis on 0141 201 4553.   

Hep B vaccine - school mop-up   
 
Please note that school nurses are responsible for vaccinating 
pupils who missed Hep B vaccine at school. This is a pilot 
programme and it is important that the same 3-dose vaccine (HB 
Vax Pro) is used for all pupils and that records are maintained by 
school-health staff. Those pupils who present to GPs and 
practice nurses for vaccination should be directed to the school- 
health services. 
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Increase in syphilis cases   
 
Dr Jim McMenamin (CPHM) has written (03/12/01) to all GPs and 
hospital  clinicians alerting them to the increase in syphilis cases 
reported to the GGNHS Board in recent months. The cases have 
been found in heterosexuals (both sexes) and homosexual men 
and occur against a backdrop of increased reports in Brighton, 
Manchester and London over the last two years.  Attached to 
the letter is a summary of signs/symptoms of infection since 
few clinicians will have seen an actual case.   
 
Where syphilis is a differential diagnosis, or there is laboratory 
confirmation of infection, then GPs are advised to contact one of 
the genito-urinary medicine consultants at the Sandyford 
Initiative Greater Glasgow (211 8601). Although a serious 
infection, syphilis is curable if treated early with antibiotics.  
Please note that the sexual health clinic at the Sandyford 
Initiative provides a confidential walk-in service Mon-Fri from 
8.30 - 10.00 am. 

 
Flu vaccine uptake  
 
A reminder that the Chief Medical Officer has set an uptake- 
target of 65% for the 65yrs+ age group.  The overall uptake- 
rate for GGNHS Board during the first month of vaccination (at 
end October 2001) was 48.7% (a similar figure for the same 
time-point in 2000).  The vaccination rates across the LHCCs 
vary between 41.7% and 60.4%.  
 
In recognition of the higher target set for this year, GGNHSB is 
working with the Primary Care Trust (Terry Findlay  
(Terry.Findlay@gartnavel.glacomen.scot.nhs.uk) to offer 
assistance, if required, to those practices anticipating, or 
experiencing, difficulty achieving the 65% target and those 
which have not yet provided information (59 practices) to the 
Scottish Centre for Infection and Environmental Health in their 
monthly returns (Ann Smith Ann.Smith@scieh.csa.scot.nhs.uk).  
 
In the event of any local difficulty in obtaining flu vaccine there 
remains plentiful contingency stock vaccine in the Leverndale 
pharmacy  which is accessible to community pharmacists.    
 
Zanamivir (neuraminidase inhibitor) remains on the approved 
Formulary of Drugs for Greater Glasgow. This reflects the NICE 
guidance from late 2000.  Note that restrictions on use include 
prescribing only when the rate of flu-like illness > 50 per 
100,000  (current rates are well below this threshold as we go to 
press). 
 

MMR update  
 
The news last week that the General Medical Council was to take 
no action against the GP who administered single measles, mumps 
and rubella vaccines, may lead some to misinterpret the outcome.  
This judgement does not mean that there has been a change of 
government policy regarding the MMR triple vaccine.  
 
The Scottish Executive has reiterated that all the evidence 
suggests that MMR vaccine is safe. Other organisations who 
support this view are the Department of Health, Joint 
Committee on Vaccination and Immunisation (JCVI), Committee 
on Safety of Medicine (CSM), BMA, Medical Research Council 

(MRC) and World Health Organisation  (WHO). 
 

Hot turkey ! 
 
We continue to get frequent reports of salmonella and 
campylobacter infection, along with other food-poisoning 
organisms. Confirmed cases (with the exception of  
Campylobacter infections) are investigated by food-safety 
officers from local environmental health departments. Most 
infections are sporadic and many are attributed to undercooked 
meat or poultry prepared at home.  
 
Please follow these basic steps to reduce the risk of food 
poisoning at home: 
 
 
• Always keep raw and cooked meats and poultry separately 
• Clean ALL surfaces and utensils thoroughly following food 

preparation 
• Store raw meat and poultry in a covered container at the 

bottom of the fridge 
• Keep the fridge temperature between 00- 40 C 
• Thoroughly defrost frozen meat and poultry before cooking 

(check defrosting instructions on the wrapper) 
• Cook meat and poultry thoroughly until juices run clear  
• NEVER eat raw eggs 
• Wash salads, fruit and vegetables in clean, running water 
• Wash hands BEFORE and AFTER food preparation 
 
 
Watch the birdie ! 
 
With Christmas round the corner 
Let's stop and pause for thought 
About the possible dangers  
Where you may well get caught          
 
The choice of goose or turkey 
Is really up to you 
But please defrost it thoroughly 
And cook it through and through 
 
Place it in the oven 
Seasoning's up to you  
Remember, remove the giblets 
To let the heat go through  
 
Cooking time is variable  
Weight dictates how long 
There's time to join the party 
To recite or sing a song 
 
The temperature is important 
Make sure you get it right      
If you cook the stuffing separate  
You'll have a tasty, less fatty bite   
 
 
(by The Basting Bard) 
 
 
 
 
If you have any comments about any aspect of this 
newsletter (except the poetry) please contact Dr Marie 
Laurie, Public Health (0141 201 4933) 

mailto:Terry.Findlay@gartnavel.glacomen.scot.nhs.uk
mailto:Ann.Smith@scieh.csa.scot.nhs.uk
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This sidebar article was created with a text box. You can use 
a sidebar article for any information you want to keep 
separate from other articles or information that highlights an 
article next to it. These could include a list of contributors, 
addresses or contact information, a smaller self-contained 
story, a preview of the next issue, or a calendar of schedule. 
The example below shows a Calendar of Events. 

C A L E N D A R  O F  E V E N T S  
SPECIAL EVENT 

PLACE 
TIME 
Type a description of your event here. 

SPECIAL EVENT 

PLACE 
TIME 
Type a description of your event here.  

SPECIAL EVENT 

PLACE 
TIME 
Type a description of your event here.  

SPECIAL EVENT 

PLACE 
TIME 
Type a description of your event here. 

Template 
Type your sub-heading here 

Your By-line 
Your Company Name 

To keep these instructions, choose Print from the File 
menu. Press Enter to print the template. Replace the 
sample text with your own text to create your 
newsletter. 

Using Styles in This Template 
To change the Style of any paragraph, select the text 
by positioning your cursor anywhere in the paragraph. 
Select a Style from the drop-down Style list at the top-
left of your screen. Press Enter to accept your choice. 

 

See Page 4 to learn how to edit or replace this picture. 

The styles available in this template allow you to 
change the look of your headlines and other text. The 
following is a list of some common styles and their 
uses. 

Body Text - Use this style for the regular text of an 
article. 

Byline - Use this style for the name of the author of an 
article. 

Byline Company - Use this style to type the author’s 
company. 

SIDEBAR HEAD - Use this style to type a second-level 
heading in a sidebar article. 

SIDEBAR SUBHEAD - Use this style to type a third-level 
heading in a sidebar article. 

Sidebar Text - Use this style to type the text in a 
sidebar article



 
 
 M O R E  W A Y S  T O  C U S T O M I Z E  T H I S  
T E M P L A T E  

Inserting and Editing 
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Return Address 
Street Number and Name 
City, State  98765-4321 
 

 BULK RATE 

US POSTAGE 

PAID 

PERMIT NO. 

98765 

  
ADDRESS CORRECTION REQUESTED Mailing Address 

Street Number and Name 
City, State  98765-4321 

 
 
 
 

FOOTERS 

To change the text at the very bottom of each page of your 
newsletter, click Headers and Footers on the View menu. 
Use the Header and Footer toolbar to open the footer, and 
replace the sample text with your own text. 

INSERT SYMBOL 

It is a good idea to place a small symbol at the end of each 
article to let the reader know that the article is finished and 
will not continue onto another page. Position your cursor at 
the end of the article, click Symbol on the Insert menu, 
choose the symbol you want, and then click Insert. 

BORDERS 

You can use page borders and text box borders to change 
the appearance of your newsletter. Borders on text boxes 
help keep different articles separate, and can set off sidebar 
articles from the rest of the page. To change a text box 
border, select it, double click its edge and choose the Colors 
and Lines tab in the Format Auto Shape dialog box. 

Pictures 
Type your sub-heading here 

You can replace the pictures in this template with your 
company’s art. Select the picture you want to replace, 
point to Picture in the Insert menu, and click From File. 
Choose a new picture and then click Insert. Select the 
Link to File box if you don’t want to embed the art in 
the newsletter. This is a good idea if you need to 
minimize your file size; embedding a picture adds 
significantly to the size of the file. 

To edit a picture, click on it to activate the Picture 
toolbar. You can use this toolbar to adjust brightness 
and contrast,  

Choose a new picture, and click the Link to File 
box if you don’t want to save the art with the 

newsletter. 

change line properties and crop the image. For more 
detailed editing, double-click on the graphic to activate 
the drawing layer. ! 
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